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SUMMARY:  20 
Engineered tissues heavily rely on proper vascular networks to provide vital nutrients and gases 21 
and remove metabolic waste. In this work, a stepwise seeding protocol of endothelial cells and 22 
support cells creates highly organized vascular networks in a high-throughput platform for 23 
studying developing vessel behavior in a controlled 3D environment. 24 
 25 
ABSTRACT:  26 
The cardiovascular system is a key player in human physiology, providing nourishment to most 27 
tissues in the body; vessels are present in different sizes, structures, phenotypes, and 28 
performance depending on each specific perfused tissue. The field of tissue engineering, which 29 
aims to repair or replace damaged or missing body tissues, relies on controlled angiogenesis to 30 
create a proper vascularization within the engineered tissues. Without a vascular system, thick 31 
engineered constructs cannot be sufficiently nourished, which may result in cell death, poor 32 
engraftment, and ultimately failure. Thus, understanding and controlling the behavior of 33 
engineered blood vessels is an outstanding challenge in the field. This work presents a high-34 
throughput system that allows for the creation of organized and repeatable vessel networks for 35 
studying vessel behavior in a 3D scaffold environment. This two-step seeding protocol shows that 36 
vessels within the system react to the scaffold topography, presenting distinctive sprouting 37 
behaviors depending on the compartment geometry in which the vessels reside. The obtained 38 
results and understanding from this high throughput system can be applied in order to inform 39 
better 3D bioprinted scaffold construct designs, wherein fabrication of various 3D geometries 40 
cannot be rapidly assessed when using 3D printing as the basis for cellularized biological 41 
environments. Furthermore, the understanding from this high throughput system may be utilized 42 
for the improvement of rapid drug screening, the rapid development of co-cultures models, and 43 
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the investigation of mechanical stimuli on blood vessel formation to deepen the knowledge of 44 
the vascular system.  45 
 46 
INTRODUCTION:  47 
The field of tissue engineering is rapidly progressing towards the fabrication of engineered 48 
constructs to replace missing or damaged organs and tissues1. However, fully functional 49 
constructs have yet to be achieved, in part, since generating operational vascular networks for 50 
tissue nourishment remains an outstanding challenge. Without proper vascularization, 51 
engineered tissues are limited to a passive diffusion transport of oxygen and nutrients, 52 
constraining the maximum viable tissue thickness to the diffusion limit, approximately 200 µm2. 53 
Such thicknesses are not suitable to repair large tissue defects or for full organ fabrication, which 54 
renders the presence of functional vascular network a mandatory characteristic for functional 55 
and implantable tissues3. 56 
 57 
The vascular system is comprised of a wide variety of blood vessels, with different sizes, 58 
phenotypes, and organization, tightly related to the host tissue. Understanding the behavior, 59 
response and migration decisions made by the developing and sprouting vessels can instruct their 60 
integration in engineered tissues4. Currently, the most common approach for creating in vitro 61 
vascular networks is combining endothelial cells (ECs) with support cells (SCs, with the capability 62 
to differentiate into mural cells), seeded within a three-dimensional micro-environment. This 63 
environment provides chemical and physical cues to allow the cells to attach, proliferate and self-64 
assemble into vessel networks2,5–8. When co-cultured, SCs secrete extracellular matrix (ECM) 65 
proteins while providing mechanical support to the ECs, which form the tubular structures. 66 
Furthermore, a cross-interaction between both cell types promote tubulogenesis, vessel 67 
sprouting and migration, in addition to the SCs maturation and differentiation into α-smooth 68 
muscle actin-expressing (αSMA) mural cells4. Vessel network development is most commonly 69 
studied in 3D environments created using hydrogels, porous polymeric scaffolds, or a 70 
combination thereof. The latter option equally provides a cell-friendly environment and the 71 
required mechanical support for both the cells and the ECM9.  72 
 73 
A great amount of work has been carried out to study vascular development, including co-74 
culturing the cells on hydrogels10, hydrogels-scaffold combinations11,12, 2D platforms, and 75 
microfluidic devices13. However, hydrogels can be easily deformed by the cell-exerted forces14, 76 
while 2D and microfluidics systems fail to recreate a closer-to-nature environment to obtain a 77 
more extrapolatable response15,16. Understanding how forming vessels react to their surrounding 78 
environment can provide critical insight that might allow for the fabrication of engineered 79 
environments with the capability of guiding the vessel development in a predictable manner. 80 
Understanding vascular formation phenomena is especially critical to keep pace with the rapid 81 
emergence of submicron-to-micron scale fabrication techniques, such as stereolithography, 82 
digital projection lithography, continuous liquid interface production, 3D melt-electro jetwriting, 83 
solution based 3D electro jet writing, and emerging bioprinting techniques17–21. Aligning the 84 
control of these micromanufacturing techniques with a deepened understanding of vascular 85 
biology is key to the creation of an appropriate engineered vasculature for a target tissue. 86 
 87 



   

Here, we present a 3D system to study the response of new forming and sprouting vessels to the 88 
surrounding scaffold geometry, observing their sprout origin and subsequent migration22. By 89 
utilizing 3D scaffolds with tessellated compartment geometries, and a two-step seeding 90 
technique, we succeeded to create highly organized vascular networks in a clear and easy to 91 
analyze fashion. The tessellated geometries provide a high throughput system with individual 92 
units containing vessels that respond to their local environment. Using multicolored ECs, we 93 
tracked sprout formation origins and subsequent migration patterns, correlated to the 94 
compartment geometry and the SCs location22.  95 
 96 
Although the proposed protocol has been prepared to analyze the effects of geometrical cues on 97 
vascularization behavior, this approach can be expanded and applied to a variety of new 98 
applications. The tessellated scaffold and the easily imageable networks allow for the 99 
straightforward analysis of different ECs and SCs interaction, the addition of specific organ cells 100 
and their interaction with the vascular networks, drug effect on vascular networks, and more. 101 
Our suggested system results very versatile and of simple fabrication and processing. 102 
 103 
PROTOCOL:  104 
 105 
1. Tessellated scaffold fabrication  106 
 107 
NOTE: Photolithography is a widespread technique with many resources accessible to 108 
researchers. It requires specialized equipment typically housed within a nanofabrication 109 
facility/laboratory. The method laid out in this protocol was generalized as much as possible for 110 
the audience; however, slight changes to procedures may be necessary depending on equipment 111 
available to the reader. We recommend performing these procedures in a clean room at a 112 
nanofabrication facility (or with an experienced laboratory) to ensure the highest process quality. 113 
If photolithography has never been performed before, it would be good to seek advice from an 114 
experienced group. Before beginning, obtain access to a mask-aligner (or some UV-exposure set-115 
up), a spin coater, hot plates, a solvent washing station, a photomask, and potentially a plasma 116 
cleaner. The solvents and chemicals used in procedure are hazardous, so please take the upmost 117 
care to avoid any chemical exposure. When designing the photomask, identify what sized silicon 118 
wafers and photomasks are compatible with the spin-coater and mask-aligner. Additionally, the 119 
photoresist located toward edges of the silicon wafer is typically deformed from handling; hence, 120 
make the designs toward the center area of the wafer.  121 
 122 
1.1. Prepare scaffolds using a photolithography technique with the selected geometry of 123 
interest. 124 
 125 
1.1.1. Before spin coating, clean the silicon wafer. This can be done with plasma cleaning or a 126 
solvent cleaning technique. If plasma cleaning, follow the standard operating procedure of the 127 
instrument for operational details. In either case, ensure the wafer is free of 128 
defects/contamination. Spray with compressed nitrogen gas and inspect the wafer to ensure it is 129 
free of debris before spin-coating. This wafer will serve as the substrate in which the scaffolds 130 
are created.  131 



   

 132 
NOTE: For best results start with a fresh wafer. Wafers can be re-used but should be cleaned and 133 
free of old photoresist, surface defects and debris. Be sure to never touch the surface of the 134 
wafer, except toward the outer edge where you do not have any design features. It is helpful to 135 
use wafer-tweezers when handling. Silicon wafers vary in size, and what size wafer used will be 136 
depend on the accessible equipment.  137 
 138 
1.1.2. Center a silicon wafer onto the spin-coater chuck using a guide. Briefly spin the wafer to 139 
ensure it has been properly centered on the chuck, adjust as necessary until properly centered. 140 
This must be done every time a wafer is placed on the spin-coater. Dispense 1-4 mL of the lift-off 141 
reagent onto the wafer (this will depend on the size of the wafer). Approximately 2 mL of lift-off 142 
reagent works well for a 4-inch wafer.  143 
 144 
1.1.2.1. Set spin-coater spread speed at 500 rpm for 5 seconds, and the spin-speed to 1000 145 
rpm for 30 seconds, then spin the lift-off reagent. Inspect the wafer to ensure it has an even 146 
coating across the wafer. Any debris left on the wafer will be very obvious at this point. Any 147 
scaffolds in that area will likely be unusable. After spin coating, transfer to a hot plate and bake 148 
for 1 minute at 200 °C. 149 
 150 
1.1.3. Repeat the previous step two more times for a total of three coatings. 151 
 152 
1.1.4. Spin-coat the Omnicoat-coated silicon wafer with SU-8 2050 photoresist until obtaining a 153 
thickness of approximately 100 µm.  154 
 155 
1.1.4.1. Dispense 1 mL of resist for every 25 mm of substrate diameter.  156 
 157 
NOTE: Be careful to avoid bubbles while pouring the resist. For SU-8 2050, pouring approximately 158 
a 2-inch diameter circle, when using a 4-inch silicon wafer works well.  159 
 160 
1.1.4.2. Spin-coat the SU-8 2050. Spread at a speed of 500 rpm for 5 seconds, followed by 161 
a spin speed between 1700 to 1800 rpm to achieve approximately 100 µm thickness.  162 
 163 
1.1.4.3. Optional: After spinning, leave the spin coated wafers to de-gas overnight on a 164 
level surface protected from light prior to the pre-bake. This may help to rid the resist of any 165 
bubbles and allow defects to level out.  166 
 167 
NOTE: The actual thickness of the resist and the resultant scaffolds can vary with user error and 168 
equipment parameters. Therefore, the thickness of the scaffolds should be verified later, in step 169 
1.6. Modify spin coating procedures accordingly to achieve the desired thickness.  170 
 171 
1.1.5. Prior to exposure, pre-bake the wafers at 65 °C for 10 min and then 95 °C for 40-50 min. 172 
Prior to exposure, test the surface of the resist by pressing on the edge with a pair of tweezers 173 
to ensure that it is no longer tacky/viscous. It is helpful to pull the wafer off of the hot plate and 174 
allow it to cool for a 0.5-1 min before assessing the tackiness. 175 



   

 176 
NOTE: Slow temperature ramp times (heating and cooling) may help to prevent warping of the 177 
scaffolds.  178 
 179 
1.2. Expose the photoresist to UV light (350-400 nm) through a photomask with an exposure 180 
energy of 215-240 mJ/cm2 for a resist thickness of 85 – 110 µm. Refer to photoresist 181 
manufacturer guidelines for recommended exposure energy-thickness correlations.  182 
 183 
1.2.1. Ensure that the exposure is properly calibrated such that the energy is verified. Adjust the 184 
exposure time as necessary to achieve desired exposure energy. Furthermore, mask aligners may 185 
allow for different exposure modes: vacuum contact, hard contact, soft contact, and proximity 186 
contact (specific terms may vary). Generally, these will impact resolution and feature alignment. 187 
The authors typically used a “hard contact” mode; however, with the large feature sizes (>30 188 
µm), it is unlikely to significantly impact the results.  189 
 190 
1.2.2. For small features or multiple layers, where alignment will matter, consider exposure 191 
modes and mask aligner procedures more carefully. Be sure to consider the height of the resist 192 
when adjusting the thickness value. Refer to the standard operating procedures of your mask-193 
aligner for operation details.  194 
 195 
NOTE: The design of the photomask will determine the scaffolds size, compartment geometry, 196 
and number of scaffolds obtained per batch. The use of a hard glass or quartz photomask will 197 
yield the highest resolution; however, a soft polymer transparent film photomask generally can 198 
be used for these large feature sizes (>10 µm). The use of a film-photomask may lead to 199 
topographical features along the z-axis of the scaffold pores as a result of poorer feature 200 
resolution. This could potentially have an influence on cell behavior. Verify the desired resolution 201 
and consult with whomever is producing the photomask before deciding because this will change 202 
depending on how the photomasks are produced.  203 
  204 
1.3. Bake the wafer immediately after UV exposure at 65 °C for 2-5 minutes and then at 95 °C 205 
for 8-10 minutes.  206 
 207 
1.4. Develop the scaffolds to remove undeveloped resist. 208 
 209 
1.4.1. Immerse the scaffolds using a low volume of SU-8 developer solution for 7-10 minutes to 210 
dissolve any undeveloped resist.  211 
 212 
1.4.2. Rinse with isopropyl alcohol (IPA).  213 
 214 
1.4.3. Dry wafer with compressed nitrogen.  215 
 216 
NOTE: Be careful during step 1.4 to not cause premature release of the scaffolds. Low volumes 217 
of developer and gentle handling are necessary to achieve this. 218 
 219 



   

1.5. Following development, hard bake the wafers at 150 °C for 15 min.  220 
 221 
NOTE: After hard bake, turning off the hotplate to allow the wafers to cool very slowly may be 222 
advantageous in preventing warping/curling of the final scaffolds.  223 
 224 
1.6. Optional: Following the hard bake and prior to lift-off, assess scaffold thickness since the 225 
scaffolds should still be gently adhered to the surface of the wafer. For this procedure, contact 226 
profilometry works well; however, any appropriate method could be employed. 227 
  228 
1.7. Lift the scaffolds off the wafer.  229 
 230 
1.7.1. Submerge the scaffolds in SU-8 developer to cause them to immediately lift off the wafer. 231 
If scaffolds do not lift off, gently push the scaffolds with a pair of wafer-tweezers.  232 
 233 
1.7.2. Remove excess developer. 234 
 235 
1.7.3. Transfer the scaffolds into new container and submerge in isopropyl alcohol. Rinse in IPA 236 
for a minimum of 6 times to ensure all developer has been removed.  237 
 238 
1.8. Air dry the scaffolds for a minimum of a week before use.  239 
 240 
2. Scaffold fibronectin coating  241 
 242 
2.1. For disinfection, submerge the scaffolds in 70% ethanol (v/v) for a minimum of 15 243 
minutes, and wash 2 times in phosphate buffered saline (PBS) before use. 244 
 245 
CAUTION: The SU-8 scaffolds are frail and can break easily. Handling is recommended using blunt 246 
and curved-tip forceps, and they should be handled with upmost care. Easier handling can be 247 
achieved by submerging the scaffolds in liquid, to avoid electrostatic interactions between the 248 
scaffolds and the surface. 249 
 250 
2.2. Prepare a dilution of 50 µg/mL of human fibronectin in PBS and cover the scaffolds by 251 
protein adsorption. 252 
 253 
2.2.1. Mix 1.5 µL of fibronectin stock solution (1 mg/mL) with 28.5 µL of PBS per each scaffold 254 
to be seeded. Preferably, prepare only one fibronectin dilution to be used for all scaffolds to avoid 255 
pipetting errors. 256 
 257 
2.2.1.1. For 10 scaffolds, mix 15 µL of stock fibronectin solution in 285 µL of PBS, 258 
amounting to a total of 300 µL of 50 µg/mL fibronectin dilution. 259 
 260 
2.2.2. Place the scaffolds sparsely on top of a hydrophobic surface (i.e., non-tissue culture 261 
(nonTC) 10 cm dish) and cover each scaffold with 30 µL of the fibronectin dilution prepared in 262 
step 2.2.1. 263 



   

 264 
CAUTION: Make sure that no bubbles are trapped in the scaffold compartments. If bubbles are 265 
present, they can be removed by gently shaking the scaffold within the droplet or light pipetting. 266 
 267 
2.2.3. Replace the plate’s lid and place the fibronectin-covered scaffolds into an incubator with 268 
37 °C and 100% humidity for a minimum of an hour.  269 
 270 
2.2.4. After incubation, lightly rinse the scaffolds in PBS to remove fibronectin remnants. The 271 
scaffolds can be kept in PBS at 4 °C for up to a week before use. 272 
 273 
3. Endothelial cells seeding  274 
 275 
3.1. Prepare EC medium by mixing the basal medium with its correspondent medium kit 276 
components, including an antibiotic solution (Pen/Strep), fetal bovine serum (FBS), and 277 
endothelial cell growth supplements, as indicated by the manufacturer.  278 
 279 
3.2. Make a human adipose microvascular endothelial cell (HAMEC) suspension in EC medium 280 
with a concentration of 4 x 106 cells/mL.  281 
 282 
NOTE: Real time imaging can be performed if the used endothelial cells are previously transfected 283 
to express a fluorescent protein, or pre-stained using a non-toxic cytoplasmic membrane dye 284 
(furtherly referred as labeled ECs). 285 
  286 
3.3. Using forceps, place one fibronectin-coated scaffold per well on a nonTC 24-well plate 287 
well.  288 
 289 
3.4. Cover each scaffold with 25 µL droplets of the HAMEC suspension. Beware not to let the 290 
suspension flow away from the scaffold, since it can hinder cell adhesion. 291 
 292 
3.5. Put the lid on the plate and place it in an incubator at 37 °C, 5% CO2 and 100% humidity. 293 
Let incubate for a minimum of 60 minutes and a maximum of 90 minutes. 294 
 295 
NOTE: During incubation, placing the plate on an orbital shaker within the incubator improves 296 
cell attachment onto the scaffold’s walls. The orbital shaker should be set at no more than 5 rpm. 297 
 298 
3.6. After incubation, fill each well with 700 µL of EC medium using a pipette. 299 
 300 
NOTE: Expect to see ECs at the bottom of the well, since some of the cells do not attach to the 301 
scaffold and fall through the scaffold’s voids. 302 
 303 
3.7. Incubate the endothelialized scaffolds until EC confluence can be observed using 304 
fluorescent microscopy on the scaffold’s walls (when using labeled ECs), or for 3 days (when using 305 
non-labeled ECs), which provides enough time to achieve EC confluence. Change the medium 306 
every other day. 307 



   

 308 
4. Support cell seeding and co-culture 309 
 310 
4.1. Prepare dental pulp stem cell (DPSC) medium (DPSCm) by mixing 500 mL of low-glucose 311 
Dulbecco’s modified Eagle medium (low-glucose DMEM), 57.5 mL of FBS, 5.75 mL of non-312 
essential amino acids (NEAA), 5.75 mL of GlutaMAX, and 5.75 mL of penicillin-streptomycin-313 
nystatin solution. 314 
 315 
4.2. Transfer the endothelialized scaffolds into a new nonTC 24-well plate to discard ECs 316 
attached to the wells’ bottom using forceps.  317 
 318 
4.2.1. Discard all media from the current plate using a 1 mL pipette, or vacuum suction. Be 319 
careful not to apply vacuum straight on the scaffold. 320 
 321 
4.2.2. Place one scaffold per well, preferably at the center of the well to avoid running liquid 322 
toward the walls due to surface tension effects. Dry the area surrounding the scaffold with light 323 
vacuum but avoid complete drying of the scaffold. 324 
 325 
4.3. Prepare a DPSC suspension in fibrin pre-gel solution. 326 
 327 
4.3.1. Dilute thrombin and fibrinogen stock solutions with PBS until obtaining a final 328 
concentration of 5 U/mL and 15 mg/mL, respectively.  329 
 330 
4.3.2. Prepare an 8 x 106 DPSC/mL suspension in the 5 U/mL thrombin dilution and distribute in 331 
individual eppendorfs 12.5 µL of said suspension per scaffold to be seeded.  332 
 333 
4.3.3. Set a 5-50 µL pipette (or similar) to 12.5 µL and fill it with the 15 mg/mL fibrinogen 334 
solution. 335 
 336 
4.3.4. Without removing the tip, set the pipette to 25 µL. The material in the tip should rise and 337 
leave an empty volume towards the tip opening.  338 
 339 
4.3.5. Slowly press the plunger button until the liquid reaches the tip opening but does not leak 340 
out. Hold the plunger in this position and put the tip into one of the microcentrifuge tubes 341 
containing the cells in thrombin suspension, making sure the tip is in contact with the liquid. 342 
 343 
CAUTION: The fibrin crosslinking will begin immediately after the thrombin and fibrinogen come 344 
into contact. The following step should be done quickly. 345 
 346 
4.3.6. Gently release the plunger button and draw the cell suspension into the tip. Thoroughly 347 
mix both materials, avoiding bubble formation.  348 
 349 
4.4. Quickly dispense the mixed materials on top of an endothelialized scaffold. Repeat the 350 
previous steps for each scaffold, making sure to always change tips between uses to avoid 351 



   

unexpected fibrin gel formation within the tip.  352 
 353 
4.5. Replace the plate lid and incubate the scaffolds at 37 °C, 5% CO2 and 100% humidity for 354 
30 minutes. 355 
 356 
4.6. After incubation, fill each well with 1 mL of 1:1 DPSC and EC medium.  357 
 358 
4.6.1. Culture for 1 week, changing medium every other day. 359 
 360 
4.6.2. During culture, remove the medium from the well and image the constructs using a 361 
confocal microscope at different time points to study the vascular development or any other 362 
parameter of interest. 363 
 364 
NOTE: This step can only be performed if the experiment is performed using labeled ECs. See 365 
Step 6 - NOTE for further clarification. 366 
 367 
5. Immunofluorescent staining for characteristic vascular markers 368 
 369 
NOTE: The following steps can be performed in the same wells where the constructs were 370 
cultured. It is critical to always make sure that the solutions completely cover the scaffolds. 371 
Moreover, when possible, performing the steps on an orbital shaker is recommended, although 372 
not mandatory. 373 
 374 
5.1. At day 7, discard the media from the wells and rinse the scaffolds by adding PBS to the 375 
wells, and removing it using vacuum. 376 
 377 
5.2. Fix the scaffolds by adding 4% paraformaldehyde for 20 minutes. Wash in PBS 3 times, 5 378 
minutes per wash. 379 
 380 
5.3. Permeabilize the fixed cells using 0.3% Triton-X in PBS (v/v) for 15 minutes. Wash in PBS 381 
3 times, 5 minutes per wash.  382 
 383 
5.4. Prepare a 5% bovine serum albumin (BSA) in PBS (w/v) blocking solution and cover the 384 
scaffolds. Leave at room temperature for 1 hour. 385 
 386 
NOTE: All the required solution amounts will depend on the number of scaffolds to be stained. 387 
Prepare the solutions as needed keeping the stated concentrations. 388 
 389 
5.5. Prepare and apply the primary antibodies staining solution . 390 
 391 
5.5.1. Dilute rabbit anti-von Willebrand factor (vWF) antibody 1:150 and mouse anti-SMA 392 
antibody 1:50 in fresh blocking solution. 393 
 394 
NOTE: Other endothelial cells markers, such as CD31 or VE-Cadherin can be used.  395 



   

 396 
5.5.2. Cover the scaffolds with the primary antibodies solution and keep at 4 °C overnight. Wash 397 
in PBS three times, 5 minutes per wash. 398 
 399 
5.6. Prepare and apply the secondary antibodies staining solution. 400 
 401 
5.6.1. Dilute goat anti-mouse Cy3 antibody 1:150 and goat anti-rabbit Alexa-Fluor 488 1:400 in 402 
PBS. 403 
 404 
5.6.2. Cover the scaffolds with the secondary antibodies solution and incubate for a minimum 405 
of 3 hours at room temperature, or at 4 °C overnight. Wash 3 times in PBS, 5 minutes per wash. 406 
Keep stained scaffold in 0.3% PFA in PBS (v/v) for up to a month. 407 
 408 
6. Scaffold confocal imaging and vessel development analysis 409 
 410 
NOTE: The following steps can be performed on the fixed and stained scaffolds at the chosen 411 
final time point or, if fluorescent cells were used, during the cell culture period without the need 412 
to terminate the experiment. For the latter, it is recommended to set specific time points; this 413 
work shows day 0 (before SCs seeding), and days 1, 3, 5 and 7 after SCs seeding (Figure 3A).  414 
 415 
6.1. Image the scaffolds using a confocal microscope with a 5X lens and a zoom of 0.5 and the 416 
full z range of the scaffold. This will allow to capture 9 separate compartments for the squared 417 
and circular geometries, or 8 full compartments for the hexagonal geometry. Image the 418 
fluorescent signal and the transmitted light, to get both the vessel network structure and the 419 
compartment geometry (Figure 3A). 420 
 421 
6.2. Using ImageJ (or any other image processing software), crop each individual 422 
compartment; for this process, only the vascular networks markers are relevant. Remove any 423 
vessel not located inside the compartment area. Create a maximum intensity projection and 424 
save each individual cropped compartment as a TIFF image. 425 
 426 
6.2.1. In ImageJ, press File > Open and select the desired TIFF image containing several 427 
compartments. The image should have at least two channels, the fluorescent vessel network, and 428 
the transmitted light image. 429 
 430 
6.2.2. From the toolbar, select the Polygon selection tool. Select the transmitted light channel. 431 
Click on one of the corners of the hexagonal compartment, at the interface between the 432 
compartment area and the scaffold wall, this will start the mask definition. Continue clicking on 433 
the next corners in a sequential order until the initial corner is selected, closing the mask. 434 
 435 
NOTE: This explanation applies to a hexagonal compartment. When the compartment is either 436 
squared or circular, use the Rectangle or Oval tools, respectively, to create an appropriate mask. 437 
Regardless the shape, always fit the mask to follow the inner wall of the scaffold. 438 
 439 



   

6.2.3. Click on Analyze > Tools > ROI manager. In the ROI manager (ROI, region of interest), click 440 
the Add button to save the created mask. The new mask will show up in the left side list. This 441 
step allows the analysis to be consistent between different images. 442 
 443 
NOTE: In the ROI manager, it is possible to save a file with all the created masks by clicking on 444 
More > Save. In the Save selection window, choose a name and location, and save the .roi file. 445 
To retrieve the mask, in the ROI manager, click on More > Open and choose the desired .roi file.  446 
 447 
6.2.4. Select the fluorescent vessel network image and click on Edit > Clear outside. Only the 448 
image contained in the mask will remain, while the rest will be eliminated. 449 
 450 
6.2.5. With the cleared network image open, click on Image > Duplicate. In the Duplicate pop-451 
up window, write the name of the image. If the Duplicate hyperstack is selected, unselect it and 452 
click OK. A new image containing only the cropped fluorescent vessel networks will be created. 453 
 454 
6.2.6. Save the cropped image by clicking on File > Save as > Tiff. Choose the name and directory 455 
and click OK. 456 
 457 
6.3. Analyze the vascular development on the cropped images. 458 
 459 
6.3.1. Download and install the analytical free software AngioTool, which provides quantitative 460 
tools to quantify a variety of vascular parameters. The software can be obtained from the 461 
following address https://ccrod.cancer.gov/confluence/display/ROB2/Home. 462 
 463 
6.3.2. Set the scale value of the images to obtain results in millimeter units and load an image. 464 
 465 
6.3.2.1. Click on the Setting tab and fill the Distance in pixels and Distance in mm with 466 
representative values from the taken images. Using the imaging parameters mentioned above, 467 
the values to fill are 400 pixels per 1 mm. 468 
 469 
6.3.2.2. Press the Open image button and browse for the image of interest. 470 
 471 
6.3.3. Choose the analysis parameters to quantify vessel development in the Analysis tab. 472 
 473 
6.3.3.1. Under the Vessel diameter and intensity field, deselect any present marker from 474 
the top range selector, and activate the marker representing the number 3.  475 
 476 
6.3.3.2. Under the Vessel diameter and intensity field, on the bottom range selector, 477 
move the lower range marker to 60, and leave the high ranger maker at 255. 478 
 479 
6.3.3.3. Activate the Remove small particles box and set the marker to 100. 480 
 481 
6.3.3.4. Under the field Saving preferences, select the name and location of the spread 482 
sheet file in which the results will be saved and press the Run analysis button. If the Save result 483 
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image box is selected, Angiotool will generate and save a new jpeg image showing the vessel 484 
network quantified parameters. 485 
 486 
NOTE: For each performed analysis without changing the spread sheet file name, a new row will 487 
be added at the bottom of the file, with the newly acquired results. 488 
 489 
6.4. Organize the data and run a statistical analysis. 490 
 491 
6.4.1. For all the processed images, choose the parameter of interest from the spread sheet 492 
(e.g. Total vessel length and Vessel area) and input them into a statistical analysis software to 493 
properly study the obtained results (Figure 3C). 494 
  495 
7. Time lapse imaging for sprouting origin detection and migration tracking 496 
 497 
7.1. Alternatively, to culturing the scaffolds in the incubator as described in step 4.6, set a 498 
confocal microscope culture chamber to 37 °C, 5% CO2 and 100% humidity.  499 
 500 
7.1.1. Put the plate containing the fully seeded scaffolds in the confocal microscope chamber 501 
and set the imaging parameters to the desired values. 502 
 503 
7.1.2. Set the image taking interval to 30 minutes, and the total imaging time of 72 hours. This 504 
will enable to run the time lapse completely without the need for a medium change. 505 
 506 
CAUTION: In case a longer time lapse imaging is desired, a careful position calibration should be 507 
performed to be able to retrieve the original imaging location, since medium changes require 508 
removing the plate from the confocal incubator and into the sterile biological hood. 509 
 510 
NOTE: ECs detachment from the scaffold walls and tubular structures formation will start within 511 
the first hour after SCs seeding (step 4) and may take up to 50 hours to complete. After initial 512 
tube formation, new sprouts will start migrating into the compartment from the surrounding 513 
vessels. Sprouting and subsequent network remodeling will continue throughout the experiment 514 
approximately until day 10, when the vessel networks become stable22. Use this information to 515 
choose the time lapse starting point and time step accordingly. 516 
  517 
7.2. Save the complete time lapse movie file as a TIFF sequence. 518 
 519 
7.3. Open ImageJ and click File > Import > Image sequence and select your files. This will open 520 
your TIFF sequence as a movie. 521 
 522 
7.4. Open the Manual Tracking plugin by clicking on Plugins > Manual Tracking. This will open 523 
the Tracking window.  524 
 525 
7.5. Observe the movie and select the vessel to be tracked. Pay attention to its origin and 526 
migration. 527 



   

 528 
7.6. Activate the Show parameters box and input the 30 minutes for Time interval. The x/y 529 
calibration will depend on the pixel amount selected during imaging.  530 
 531 
7.7. Proceed to manually track the sprouting vessels from the scaffold contour. 532 
 533 
7.7.1. Press the Add track button. On the movie’s first frame, press the location of the vessel to 534 
be tracked. After this, the movie will change to the next frame automatically.  535 
 536 
7.7.2. Click on the image of the second frame where the vessel is located. Again, the movie will 537 
change to the next frame automatically. 538 
 539 
7.7.3. Proceed with the same vessel until the full migration tracking has been completed.  540 
 541 
7.7.4. On the Tracking window, click on the Overlay Dots & Lines to imprint a visual path of the 542 
vessel migration on the movie. This will open a copy of the movie with a dot representing the 543 
current position of the tracker, and a line showing the previous path. 544 
 545 
7.7.5. Click on the End Track button to finalize recording the current vessel movement. 546 
 547 
7.7.6. Click on the Add track button again to start over with a new vessel. When doing this, the 548 
line and dot markers will automatically change their color for the new vessel. Repeat until all 549 
desired vessels are tracked. 550 
 551 
NOTE: The x/y location, vessel velocity and moved distance can be retrieved from the pop-up 552 
window Results. Each vessel will be identified by its track number in the leftmost column. This 553 
data can be copied and pasted into a spread sheet to perform further analysis. 554 
 555 
REPRESENTATIVE RESULTS:  556 
The presented protocol, using stereolithography techniques, allows for the fabrication of 557 
tessellated scaffolds made of SU-8 photoresist. Scaffolds with distinct compartment geometries 558 
(squares, hexagons, and circles), and highly accurate and repeatable features were obtained 559 
(Figure 1).  560 
 561 
[Place Figure 1 here] 562 
 563 
With a stepwise cell seeding (steps 2 to 4), the fabricated scaffolds were used to create highly 564 
organized vascular networks. When using a traditional simultaneous seeding of both ECs and SCs, 565 
the resulting vessels lacked a clear organization. For this, the scaffold fibronectin coating was 566 
performed (step 2), the scaffold endothelialization step was skipped (step 3), and the DPSC and 567 
HAMEC were simultaneously co-seeded in fibrin gel (step 4). In this fashion, the cells are 568 
homogeneously distributed over the scaffold (Figure 2, top row), resulting in unpredictable and 569 
disorganized developed vascular networks that do not seem to interact with the surrounding 570 
scaffold. Contrarily, firstly seeding the ECs on the scaffold walls provides an accurate initial 571 



   

endothelial cell patterning. The later addition of SCs within a fibrin gel results in a predictable 572 
tubulogenesis phenomenon, with forming vessels closely following the shape of the scaffold wall, 573 
and sprouting new vessels migrating into the compartment space (Figure 2, bottom row).  574 
 575 
[Place Figure 2 here] 576 
 577 
When using fluorescent ECs, either transfected or dyed, the vessels can be imaged in real time 578 
without the need to fix and terminate the experiment for each time point. Red fluorescent 579 
protein expressing ECs (RFP-ECs) were cultured on hexagonal scaffolds and imaged after seeding 580 
(Figure 3A, day 0). At day 1, the SCs were added and the vascular networks were imaged every 581 
other day to quantify the vessel development (Figure 3A, days 1, 3, 5 and 7). For each time point, 582 
wide images of the whole scaffold were taken (Figure 3B). For every compartment, the vessels 583 
mainly organized and interacted with cells located within their confinement. Hence, each 584 
compartment was isolated and the superfluous vessels outside the compartment were removed 585 
using ImageJ. The clean, single-compartment images were then analyzed using Angiotool. 586 
Angiotool returned a spread sheet file containing several vessel parameters, and a visual 587 
representation of the main network characteristics, such as skeleton, intersection points, and 588 
vessel surface. The obtained data was analyzed using the statistical analysis software Prism, and 589 
a clear vessel growth was observed for total vessel length and area during the experiment time 590 
frame (Figure 3C). During a 1-week experiment, vessels are expected to further develop and 591 
extended as shown in Figure 3A and Figure 2C. Decreasing vessel length or area, failure to form 592 
vessels by day 3 or vessels forming as shown in the top row of Figure 2 can be interpreted as a 593 
failed experiments.  594 
 595 
[Place Figure 3 here] 596 
 597 
Using multicolored ECs to facilitate single cell identification, a confocal imaging time lapse was 598 
performed to allow single vessel tracking (Supplementary Video 1). The vessels were observed 599 
and tracked using the Manual Tracking ImageJ plugin. The tip cell was selected for each frame of 600 
the movie (Figure 4A) until the vessel anastomosed with the surrounding vasculature. As a result, 601 
the Manual Tracking plugin generated the vessel path in real time, which allowed to observe the 602 
vessel migration (Figure 4B). 603 
 604 
[Place Figure 4 here] 605 
 606 
Vessel maturation, represented by the presence of SMA+ SCs, can be easily observed in the 607 
proposed platform. Vasculatures presenting higher numbers of SMA+ SCs represent a more 608 
mature network, since SMA expression correlates with vessel stabilization over time23. For the 609 
circular, hexagonal and squared compartments, the amount of SMA+ SCs increases over time 610 
(Figure 5A). By day 3, all shapes showed scattered SMA+ SCs and uncomplex vessels with few or 611 
no sprouts whatsoever. By day 7, all shapes showed a rich and complex vascular network, with a 612 
higher presence of SMA+ SCs surrounding the vessels. Furthermore, higher magnification images 613 
reveal a denser SMA+ SCs presence co-localized with formed vessels, evidencing the SCs 614 
recruitment and differentiation surrounding vascular structures (Figure 5B). 615 



   

 616 
[Place Figure 5 here] 617 
 618 
FIGURE AND TABLE LEGENDS:  619 
 620 
Figure 1: Representative scanning electron microscopy images of the tessellated square, 621 
circular, and hexagonal scaffold geometries (scale bar = 50 µm).  622 
 623 
Figure 2: Vascularization comparison between simultaneous vs. stepwise cell seeding. 624 
Representative images of vascular development in tessellated scaffolds for a simultaneous (top 625 
row) cell seeding of ECs (red) and SCs (green), and step-wise cell seeding (bottom row) at days 1 626 
and 5. The stepwise seeding results in organized vascular networks that follow the scaffold walls 627 
and sprout into the compartment space (scale bar: 100 µm). 628 
 629 
Figure 3: Representative development images and analysis of organized vascular networks. (A) 630 
ECs (red) reach confluence on the scaffold wall on which SCs are afterwards seeded; the SCs 631 
addition represents day 0 of the experiment. At day 1 after the SCs seeding, the ECs detach to 632 
the compartment space and start forming vessels that will continue sprouting and connecting at 633 
further days. (B) Confocal image processing steps for vascular network analysis (i) A wide confocal 634 
image containing several compartments is taken, (ii) a single compartment is cropped (demarked 635 
by the white dashed hexagon), (iii) then the vascular network channel is separated, and all vessels 636 
outside the compartment walls are cropped out. The single compartment image is analyzed using 637 
Angiotool, returning a list of vascular parameters complemented with visual markers, such as the 638 
vessel area (outlined in yellow), the vessels length (displayed with green lines), and the 639 
intersection points (marked as blue dots). (C) Comparative results of the total vessel length and 640 
the total vessel area within hexagonal compartments at different time points (results are 641 
presented as mean ± SD, n > 6; all scale bars: 200 µm). 642 
 643 
Figure 4: Representative sprouting vessel tracking. (A) A multicolored ECs (green, red, and blue) 644 
time lapse is used to facilitate single vessel identification. A sprouting vessel is identified and 645 
tracked using the ImageJ plugin Manual Tracking. The end side of the vessel is marked for every 646 
time point to track in real time; the black-in-white marker was added to show the selected vessel 647 
end point. (B) The resulting 2D tracking of the vessel, as processed by the ImageJ plugin, showing 648 
the farthest point with a dot, and the formed path with a line (scale bar = 200 µm). 649 
 650 
Figure 5: SMA+ SCs and blood vessels increase over time. A) Smooth muscle actin (red) and vWF 651 
(vessels, green) are shown for vascular networks in circular, squared and hexagonal 652 
compartments at day 3 and day 7. Both vasculature extension and SMA-expressing support cells 653 
(SMA+ SCs) increase over time, signifying a higher vessel maturation and complexity (scale bar = 654 
200 µm). B) Representative images of the SMA+ SCs denser accumulation around vessels at day 655 
7. The nuclei (blue) in the composite image reveal the presence of SCs not expressing the SMA 656 
protein (scale bar = 50 µm). 657 
 658 
Supplementary Video 1: multicolored ECs time lapse for vessel migration tracking.  659 



   

 660 
DISCUSSION:  661 
The need for a rich vasculature within embedded in engineered tissues is critical for construct 662 
survival and proper function1. Although engineering the vascular system has been the focus of a 663 
vast amount of research, much is left to investigate and understand24. In particular, when 664 
recreating a specific tissue, the microvasculature should behave and organize accordingly12. The 665 
most common approach for microvessels generation is co-seeding endothelial and support cells 666 
within a suitable 3D environment compatible for cell attachment, proliferation, and vessel 667 
formation25. This methodology often results in greatly unorganized networks, making it difficult 668 
to study the microvascular behavior22. Here, the presented protocol provides a new tool that 669 
generates highly organized vascular networks in a high-throughput system, with vessels that can 670 
be easily tracked and monitored through time, to study their development and behavior. The 671 
stepwise seeding of the ECs (step 2-3), followed by the SCs (step 4), are critical steps to achieve 672 
such organized networks22. Additionally, this technique presents a real 3D environment for 673 
vascular models, in which vessels can migrate in the three dimensions and create relevant 674 
structures. In contrast, more popular methods for vascular modelling, such as microfluidics 675 
systems, only offer a 2.5D tissue representation26. 676 
 677 
The proposed method can be easily modified and applied to study many different factors 678 
affecting the vessel network development and behavior. Photolithographic SU-8 resin scaffold 679 
fabrication is a common technique with an impressive versatility that enables creating a wide 680 
variety of shapes26,27, with the potential to design structures resembling complex native 681 
constructs, such as the alveoli or the nephrotic unit. Nonetheless, a drawback of using SU-8 is its 682 
low bioabsorbability27, making the platform mainly a research tool, instead of an implantable 683 
tissue. However, this could be improved by utilizing biocompatible materials which can crosslink 684 
under UV/visible light illumination, and 3D printed using accurate techniques like 685 
stereolitography29. The resulting vascularized constructs could then be implanted in an animal 686 
model30. Another limitation of the system is the scaffold maximum achievable thickness with high 687 
detail accuracy, limited by the stereolithographic technique31. The proposed protocol is suitable 688 
for creating thin scaffold which might represent native tissue sizes.  689 
 690 
This platform offers the potential to investigate several variables affecting the vascularization 691 
phenomena4,32. First, the interactions between different types of ECs and SCs, and their vessel 692 
formation, development and maturation capabilities, which are known to differ when using cells 693 
from different tissue origins33. Second, the effect of growth factors, small molecules, and 694 
inhibitors on the vasculature, allowing for a clear visualization of their impact in real time34,35. 695 
Third, the addition of other cell types, spheroids, or organoids and their communication and 696 
interaction with the forming vessels36. For this, the proposed system represents a powerful tool 697 
for investigating the microvascular system.  698 
 699 
Future steps will take advantage of the proposed system to investigate the effect of mechanical 700 
stimuli, such as interstitial flow and mechanical stretching37,38, on the developing vasculature. 701 
This will hopefully shed light on new aspects that will expand the current knowledge and state-702 
of-the-art research of the vascular mechanobiology.  703 



   

 704 
ACKNOWLEDGMENTS:  705 
This research was supported by funding from the University of Michigan – Israel Partnership for 706 
Research. The authors would like to thank Uri Merdler, Lior Debbi, Dylan Neale and Galia Ben 707 
David for their great assistance and support, Nadine Wang, Ph.D. and Pilar Herrera-Fierro, Ph.D. 708 
of the Lurie Nanofabrication Facility at the University of Michigan, as well as Luis Solorio, Ph.D. 709 
for enlightening discussions of photolithography techniques.  710 
 711 
DISCLOSURES:  712 
The authors have nothing to disclose. 713 
 714 
REFERENCES:  715 
1. Novosel, E.C., Kleinhans, C., Kluger, P.J. Vascularization is the key challenge in tissue 716 
engineering. Advanced Drug Delivery Reviews. 63 (4), 300–311 (2011). 717 
2. Landau, S., Guo, S., Levenberg, S. Localization of Engineered Vasculature within 3D Tissue 718 
Constructs. Frontiers in Bioengineering and Biotechnology. 6, 2 (2018). 719 
3. Griffith, C.K. et al. Diffusion Limits of an in Vitro Thick Prevascularized Tissue. Tissue 720 
Engineering. 11 (12) (2005). 721 
4. Potente, M., Gerhardt, H., Carmeliet, P. Basic and therapeutic aspects of angiogenesis. 722 
Cell. 146 (6), 873–887 (2011). 723 
5. Landau, S. et al. Tropoelastin coated PLLA-PLGA scaffolds promote vascular network 724 
formation. Biomaterials. 122, 72–82 (2017). 725 
6. Lesman, A. et al. Engineering vessel-like networks within multicellular fibrin-based 726 
constructs. Biomaterials. 32 (31), 7856–7869 (2011). 727 
7. Richards, D., Jia, J., Yost, M., Markwald, R., Mei, Y. 3D Bioprinting for Vascularized Tissue 728 
Fabrication. Annals of Biomedical Engineering. 45 (1), 132–147 (2017). 729 
8. Levenberg, S. et al. Engineering vascularized skeletal muscle tissue. Nature Biotechnology. 730 
23 (7), 879–884 (2005). 731 
9. Rouwkema, J., Khademhosseini, A. Vascularization and Angiogenesis in Tissue 732 
Engineering: Beyond Creating Static Networks. Trends in Biotechnology. 34 (9), 733–745 (2016). 733 
10. Miller, J.S. et al. Rapid casting of patterned vascular networks for perfusable engineered 734 
three-dimensional tissues. Nature Materials. 11 (2012). 735 
11. Gariboldi, M.I., Butler, R., Best, S.M., Cameron, R.E. Engineering vasculature : 736 
Architectural effects on microcapillary-like structure self-assembly. PLOS ONE. 14 (1), 1–13 737 
(2019). 738 
12. Blache, U., Guerrero, J., Güven, S., Klar, A.S., Scherberich, A. Microvascular Networks and 739 
Models, In vitro Formation. Vascularization for Tissue Engineering and Regenerative Medicine. 740 
1–40 (2018). 741 
13. Wong, K.H.K., Chan, J.M., Kamm, R.D., Tien, J. Microfluidic Models of Vascular Functions. 742 
Annual Review of Biomedical Engineering. 14 (1), 205–230 (2012). 743 
14. Jansen, K.A., Bacabac, R.G., Piechocka, I.K., Koenderink, G.H. Cells actively stiffen fibrin 744 
networks by generating contractile stress. Biophysical Journal. 105 (10), 2240–2251 (2013). 745 
15. Pollet, A.M.A.O., den Toonder, J.M.J. Recapitulating the vasculature using Organ-on-Chip 746 
technology. Bioengineering. 7 (1) (2020). 747 



   

16. Hasan, A. et al. Microfluidic techniques for development of 3D vascularized tissue. 748 
Biomaterials. 35 (26), 7308–7325 (2014). 749 
17. Jordahl, J.H. et al. 3D Jet Writing: Functional Microtissues Based on Tessellated Scaffold 750 
Architectures. Advanced Materials. 30 (14), 1707196 (2018). 751 
18. Gauvin, R. et al. Microfabrication of complex porous tissue engineering scaffolds using 3D 752 
projection stereolithography. Biomaterials. 33 (15), 3824–3834 (2012). 753 
19. Coscoy, S. et al. Microtopographies control the development of basal protrusions in 754 
epithelial sheets. Biointerphases. 13 (4), 041003 (2018). 755 
20. Kaplan, B. et al. Rapid prototyping fabrication of soft and oriented polyester scaffolds for 756 
axonal guidance. Biomaterials. (2020). 757 
21. Steier, A., Muñiz, A., Neale, D., Lahann, J. Emerging Trends in Information‐Driven 758 
Engineering of Complex Biological Systems. Advanced Materials. 31 (26), 1806898 (2019). 759 
22. Szklanny, A.A. et al. High‐Throughput Scaffold System for Studying the Effect of Local 760 
Geometry and Topology on the Development and Orientation of Sprouting Blood Vessels. 761 
Advanced Functional Materials. 1901335 (2019). 762 
23. Welti, J., Loges, S., Dimmeler, S., Carmeliet, P. Recent molecular discoveries in 763 
angiogenesis and antiangiogenic therapies in cancer. Journal of Clinical Investigation. 123 (8), 764 
3190–3200 (2013). 765 
24. Gui, L., Niklason, L.E. Vascular Tissue Engineering: Building Perfusable Vasculature for 766 
Implantation. Current Opinion in Chemical Engineering. 3, 68–74 (2014). 767 
25. Blache, U., Ehrbar, M. Inspired by nature: Hydrogels as versatile tools for vascular 768 
engineering. Advances in Wound Care. 7 (7), 232–246 (2018). 769 
26. Cochrane, A. et al. Advanced in vitro models of vascular biology: Human induced 770 
pluripotent stem cells and organ-on-chip technology. Advanced Drug Delivery Reviews. 140, 68–771 
77 (2019). 772 
27. Nemani, K. V, Moodie, K.L., Brennick, J.B., Su, A., Gimi, B. In vitro and in vivo evaluation of 773 
SU-8 biocompatibility. Materials Science & Engineering. C, Materials for Biological Applications. 774 
33 (7), 4453–9 (2013). 775 
28. Mathew, R., Ravi Sankar, A. A Review on Surface Stress-Based Miniaturized Piezoresistive 776 
SU-8 Polymeric Cantilever Sensors. Nano-Micro Letters. 10 (2), 1–41 (2018). 777 
29. Knowlton, S., Yenilmez, B., Anand, S., Tasoglu, S. Photocrosslinking-based bioprinting: 778 
Examining crosslinking schemes. Bioprinting. 5, 10–18 (2017). 779 
30. Redd, M.A. et al. Patterned human microvascular grafts enable rapid vascularization and 780 
increase perfusion in infarcted rat hearts. Nature Communications. 10 (1), 1–14 (2019). 781 
31. Zhu, Y. et al. SU-8 Photoresist. Encyclopedia of Nanotechnology. 2530–2543 (2012). 782 
32. Zheng, F. et al. Organ-on-a-Chip Systems: Microengineering to Biomimic Living Systems. 783 
Small. 12 (17), 2253–2282 (2016). 784 
33. Freiman, A. et al. Adipose-derived endothelial and mesenchymal stem cells enhance 785 
vascular network formation on three-dimensional constructs in vitro. Stem Cell Research & 786 
Therapy. 7 (1), 5 (2016). 787 
34. van Duinen, V. et al. Perfused 3D angiogenic sprouting in a high-throughput in vitro 788 
platform. Angiogenesis. 22 (1), 157–165 (2019). 789 
35. Nguyen, D.-H.T. et al. Biomimetic model to reconstitute angiogenic sprouting 790 
morphogenesis in vitro. Proceedings of the National Academy of Sciences. 110 (17), 6712–6717 791 



   

(2013). 792 
36. Nashimoto, Y. et al. Integrating perfusable vascular networks with a three-dimensional 793 
tissue in a microfluidic device. Integrative Biology. 9 (6), 506–518 (2017). 794 
37. Rosenfeld, D. et al. Morphogenesis of 3D vascular networks is regulated by tensile forces. 795 
Proceedings of the National Academy of Sciences of the United States of America. 113 (12), 3215–796 
20 (2016). 797 
38. Neto, F. et al. YAP and TAZ regulate adherens junction dynamics and endothelial cell 798 
distribution during vascular development. bioRxiv. 174185 (2017). 799 
 800 



CircleHexagonSquare
Figure 1 Click here to access/download;Figure;Figure1.pdf

https://www.editorialmanager.com/jove/download.aspx?id=1261612&guid=0defaff9-23cc-4f1c-a62d-ac110adc30ce&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1261612&guid=0defaff9-23cc-4f1c-a62d-ac110adc30ce&scheme=1


Day 1
Si
m
ul
ta
ne
ou
s

se
ed
in
g

St
ep
w
ise

se
ed
in
g

Day 7
Figure 2 Click here to

access/download;Figure;Figure2.pd

https://www.editorialmanager.com/jove/download.aspx?id=1261613&guid=03b59e99-bfd1-4c89-acaf-d98c83fbf057&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1261613&guid=03b59e99-bfd1-4c89-acaf-d98c83fbf057&scheme=1


Day 0 Day 1 Day 3 Day 5

Vessel area Vessel length

Confluent ECs before
SC seeding

SCs and ECs coculture

Day 7

B C

A

(ii)(i)

(iii)

Figure 3 Click here to access/download;Figure;Figure3.pdf

https://www.editorialmanager.com/jove/download.aspx?id=1261614&guid=ef455040-7c16-46bc-98cd-7abe071af68a&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1261614&guid=ef455040-7c16-46bc-98cd-7abe071af68a&scheme=1


t = 15 hr t = 19 hr t = 23 hrA

B

Figure 4 Click here to
access/download;Figure;Figure4.pdf

https://www.editorialmanager.com/jove/download.aspx?id=1261649&guid=adb1f117-94b7-4d83-be19-88d9955911a2&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1261649&guid=adb1f117-94b7-4d83-be19-88d9955911a2&scheme=1


A

B

Circle
Da
y 
3

Da
y 
7

Hexagon Square

Vessels SMA+ SCs Composite

Fugure 5 Click here to access/download;Figure;Figure5.pdf

https://www.editorialmanager.com/jove/download.aspx?id=1261650&guid=c17fce44-fc06-491f-a4ed-113446987e36&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1261650&guid=c17fce44-fc06-491f-a4ed-113446987e36&scheme=1


  

Supplementary video 1

Click here to access/download
Video or Animated Figure

Supplementary Video 1.mp4

https://www.editorialmanager.com/jove/download.aspx?id=1261641&guid=97977f9a-7311-45e1-8e9d-d6ec35f2bba2&scheme=1


Name of Material/ Equipment Company Catalog Number

Angiotool freeware NIH-CCR

Bovine albumin serum Probumin Millipore 82-045-1

Dental pulp stem cells Lonza PT-5025

ECM media + bullet kit Sciencell #1001

Ethanol 96% Gadot-Group 64-17-5

Evicel fibrin sealant Johnson&Johnson EVB05IL

GlutaMAX Gibco 35050061

Goat anti-mouse Cy3 antibody Jackson 115-166-072

Goat anti-rabbit Alexa-Fluor 488 Thermo- Fisher Scientific A11034

Human adipose microvascular cells Sciencell #7200

Human fibronectin Sigma F0895-5MG

ImageJ NIH

Isopropyl alcohol Gadot-Group 67-63-0

Lift-off reagent Kayaku Advanced Materials, Inc G112850

Low-glucose DMEM Biological Industries 01-050-1A

Mouse anti-SMA antibody Dako M0851

NEAA Gibco 11140068

Paraformaldehyde solution 4% in PBS ChemCruz SC-281692
Penicillin-Streptomycin-Nystatin 

Solution Biological Industries 03-032-1B

Phospate buffered saline (PBS) Sigma P5368-10PAK

Rabbit anti-vWF antibody Abcam ab9378

Silicon wafer Silicon Valley Microelectronics (SVM)

SU-8 2050 photoresist Kayaku Advanced Materials, Inc Y11058

SU-8 developer Kayaku Advanced Materials, Inc Y020100

Tryton-X 100 BioLab LTD 57836

Table of Materials Click here to access/download;Table of Materials;List of materials
Szklanny_resubmission.xls

https://www.editorialmanager.com/jove/download.aspx?id=1261652&guid=2162130f-9984-4b60-adfd-d6e691e4dd3a&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1261652&guid=2162130f-9984-4b60-adfd-d6e691e4dd3a&scheme=1


Comments/Description

Free download at https://ccrod.cancer.gov/confluence/display/ROB2/Home

Provides both thrombin and fibrinogen (BAC2) solutions 
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1. Please take this opportunity to thoroughly proofread the manuscript to 
ensure that there are no spelling or grammar issues. Please define all 
abbreviations at first use. 
 
2. Please make the title concise: Stepwise Cell Seeding on Tessellated 
Scaffolds to Study Sprouting Blood Vessels. 
 
The title has been changed to the proposed new title. 

3. Please note that your protocol will be used to generate the script for the 
video and must contain everything that you would like shown in the video. 
Please add more details to your protocol steps. Please ensure you answer 
the “how” question, i.e., how is the step performed? Alternatively, add 
references to published material specifying how to perform the protocol 
action. Please add more specific details (e.g. button clicks for software 
actions, numerical values for settings, etc) to your protocol steps. There 
should be enough detail in each step to supplement the actions seen in the 
video so that viewers can easily replicate the protocol. 

We have provided more details to the protocol to be clearer to follow. 

4. 1.1: Please cite a reference to help readers replicate your protocol. Is the 
silicon wafer in 1.1.2 to be plasma cleaned in 1.1.1? Please clarify this. Is 
this wafer the basis of your scaffold? Please add a note in the beginning so 
the readers can follow the sequence. 

Yes, the silicon wafer in 1.1.3 is to be cleaned in 1.1.1, this has been clarified in 
the revised manuscript. Additionally, the wafer is the basis of the scaffolds, which 
has been clarified as well.  

5. JoVE cannot publish manuscripts containing commercial language. This 
includes trademark symbols (™), registered symbols (®), and company 
names before an instrument or reagent. Please remove all commercial 
language from your manuscript and use generic terms instead. All 
commercial products should be sufficiently referenced in the Table of 
Materials and Reagents. For example: Omnicoat, BAC2, FIJI, 

The terms Omnicoat, BAC2 and FIJI were replaced in the manuscript for “lift-off 
enhancing material” (LOEM), fibrinogen, and ImageJ, respectively. The 
fibrinogen was updated also in the materials table. 

6. 1.1.2, 1.1.4.2: Please convert centrifuge speeds to centrifugal force (x g) 
instead of revolutions per minute (rpm). 

Rebuttal letter Click here to access/download;Rebuttal Letter;Response to
editorial and reviewers comments.docx
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The device used in this procedure is a spin-coater, not a centrifuge. Spin-speeds 
are not reported in “x g,” as it is not a centrifuge where a force is dependent on 
the radius of the rotor. The spin-coater is only controlled by the rotor spinning at 
“X” RPM, and this is what the manufacturer’s protocols define for similar 
procedures. The authors have clarified the use of a “spin-coater” in the revised 
manuscript.   

7. 1.4.2: Please define IPA at first use if you will use it more than once, but 
use the abbreviation consistently after definition (ref: 1.8.3). 
 
This has now been corrected. 

8. 2.2.1: What is the concentration of the fibronectin solution? 

To clarify this issue, the following text (marked in yellow) was added: 

2.2.1. Mix 1.5 µl of fibronectin stock solution (1 mg/ml) with 28.5 µl of PBS per 

each scaffold to be seeded. Preferably, prepare only one fibronectin dilution to be 

used for all scaffolds to avoid pipetting errors. 

2.2.1.2. E.g. For 10 scaffolds, mix 15 µl of stock fibronectin solution in 285 µl of 

PBS, amounting to a total of 300 µl of 50 µg/ml fibronectin dilution. 

2.2.2. Place the scaffolds sparsely on top of a hydrophobic surface (i.e. non-

tissue culture (nonTC) 10 cm dish) and cover each scaffold with 30 µL of the 

fibronectin dilution prepared in step 2.2.1. 

9. 3.2: What is the EC medium composition? 
 
The text has been modified to indicate exactly how to prepare the medium. 
  
3.1. Prepare EC medium by mixing the basal medium with its correspondent 
medium kit components, including an antibiotic solution (penstrep), fetal bovine 
serum (FBS), and endothelial cell growth supplements, as indicated by the 
manufacturer.  

10. 4.2: What is a non24-well plate? 
 
Thank you for identifying this error. It was meant to be a nonTC 24-well plate, 
and it has now been corrected in the manuscript. 

11. As we are a methods journal, please add to the Discussion with 
citations: 
a) Critical steps within the protocol 
b) Any modifications and troubleshooting of the technique 
c) Any limitations of the technique 
d) The significance with respect to existing methods 



We have included more details on limitations, critical steps, modifications and 
significance to the discussion. 
 
____________________________________ 
Reviewers' comments: 
Reviewer #1: 
Manuscript Summary: 
The manuscript describes the production by photolithography of very thin 
scaffolds - termed tessellated scaffolds of various patterned types either 
repeating circles, squares or hexagons. The scaffolds are seeded with 
human adipose microvascular endothelial cells (HAMEC) and cultured for a 
number of days before dental pulp stem cells (support cells -SMactin+) in a 
fibrin gel are seeded over the HAMAC. A staining technique to identify the 
two cell types is described. The pattern of growth formed by the ECs with 
and without the support cells is observed and described for several 
methods including live confocal microscopy, and the growth of EC sprouts 
quantitated and various vessel parameters quantitated using the AngioTool 
software. 
 

Major Concerns: 
There are no major concerns. There manuscript is well written and clearly 
describes in a step-wise fashion the techniques used, with some helpful 
hints included. The figures are generally very clear. 
 
Minor Concerns: 
1) The cell types used for the model are human adipose microvascular 
endothelial cells (HAMEC) (Section 3) and dental pulp stem cells (DPSC) 
(Section 4). Although both cell types are reasonably well known there is 
absolutely no detail on how cell suspensions of these cell types are 
derived. The authors may consider this outside the scope of the 
manuscript, but references to methods describing how to obtain these two 
cell types should be included. 

We appreciate this comment from the reviewer. As it is stated in the list of 
materials, both cell types were bought from the ScienCell company and not 
obtained from ex-vivo tissues, and no part of this protocol is related to obtaining 
the cells. Furthermore, by working with bought cells, we do not feel confident to 
provide a protocol on obtaining said cells that was not tried by our lab staff first-
hand with proven results. 

2) In Section 4 Support Cell Seeding and Co-Culture section, point 4.3.1 the 
manuscripts states: 'Dilute thrombin and BAC2 stock solutions with PBS 
until obtaining a final concentration of 5U/mL and 15mg/mL, respectively'. 
Its not clear from this description that BAC2 is fibrinogen. In the 
consumables list at the end of the manuscript it is part of an Evicel Fibrin 



Sealant (Human) kit. Using only the BAC2 terminology is confusing. It 
should be clarified in the text that BAC2 is fibrinogen. 

Thank you for this comment, the proper clarifications were made to make the 
protocol more understandable: 

4.3.1. Dilute thrombin and fibrinogen stock solutions with PBS until obtaining a 
final concentration of 5 U/mL and 15 mg/mL, respectively.  
 
4.3.3. Set a 5-50 µL pipette (or similar) to 12.5 µL and fill it with the 15 mg/ml 
fibrinogen solution. 
 
CAUTION: The fibrin crosslinking will begin immediately after the thrombin and 
fibrinogen come into contact. The following step should be done quickly. 

3) Figure 2B iv) In the high resolution image the 'blue' labelling can be 
seen, although its not that obvious - could this label be made 'brighter' or 
more pronounced? 

Thank you, we fixed this to make the blue dots be more visible. 
 
4) In Figure 2C, a graph of total vessel area is presented. Is this a measure 
of the thickness of the (red) vessels by their length? Or is it some other 
measure? Please explain in more detail. 

To clarify this matter, we added to Figure 3C the contour that delineates the 
vessels after segmentation, a visual aid given by Angiotool to show the included 
surface by the freeware. In short, the surface calculation works with the intensity 
segmentation, which considers a vessel any object big enough with a pixel 
intensity over a certain threshold. After the segmentation is done, anything within 
this boundaries is considered vessel surface. 

 5) In Figure 4 (red) support cells (DPSC) are seen throughout the images, 
but close attachment of the support cells is not particularly obvious. Please 
provide a higher power image of the support cells attaching closely to the 
abluminal surface of the endothelial cells of the blood vessels. 

Figure 4 (now Figure 5) has been expanded to include an image of the close 
relation between SMA+ SCs and vessels (ECs). The image (Figure 5B) presents 
3 different images: vessels in green, SMA+ SCs in red, and a composite image 
containing the two first images plus a nuclei staining in blue to show the 
existence of SMA- SCs. In these images, it is very clear to see that the SMA+ 
SCs concentrate where vessels are found. 

The figure caption now includes the following text: 



Figure 5: SMA+ SCs and blood vessels increase over time. A) Smooth muscle 

actin (red) and vWF (vessels, green) are shown for vascular networks in circular, 

squared and hexagonal compartments at day 3 and day 7. Both vasculature 

extension and SMA-expressing support cells (SMA+ SCs) increase over time, 

signifying a higher vessel maturation and complexity (scale bar = 200 µm). B) 

Representative images of the SMA+ SCs denser accumulation around vessels. 

The nuclei (blue) in the composite image reveal the presence of SCs not 

expressing the SMA protein (scale bar = 50 µm). 

 

6) Why is Section 2: Scaffold Fibronectin Coating, highlighted in yellow - is 
this a formatting oversight? 

To create a video protocol from the provided written protocol, the editors ask the 
authors to highlight the video parts in yellow. We are not aware of if the reviewers 
are meant to see this formatting or not, since it is part of the editorial process. 
 
------------------------------------------------------------------------------------------------------------ 

 
Reviewer #2: 
Manuscript Summary: 
The authors developed a novel 3D scaffold with tessellated compartment 
geometries using photolithography technique, which was applied for 
vascularization of ECs. The article also investigated effect of the two-step 
seeding technique on vascular networks. 
 
Major Concerns: 
None 
 
Minor Concerns: 
1) Please simply explain why to choose the ratio of ECs and SCs (1:1). 
 
We appreciate the reviewer’s question. The ratio was chosen after experimenting 
with different cell concentrations, having in mind that better results are achieved 
when the cell ratio approaches 1:3 ECs:SCs when using HAMECs+DPSCs, as 
shown by Landau et al (2018). Since not all of the ECs attach to the scaffold 
surface during seeding, the number of cells remaining is approximately 30.000 to 
40.000 ECs after reaching confluence; this was quantified by trypsinizing the 
cells after reaching confluence and counting them. Since the gel entraps most of 
the seeded cells, adding 100.000 SCs per scaffold keeps the preferred 1:3 
ECs:SCs ratio.   



2) What are the standards for the preparation of the endothelialized 
scaffolds? Or just let the ECs confluence on the surface of scaffolds? 
Please make it clear. 

The endothelialized scaffolds should be cultured until confluence can be 
observed using fluorescent microscopy, or for 3 days when the used ECs are not 
fluorescent. The following changes were made in the manuscript to clarify the 
matter:  

3.7. Incubate the endothelialized scaffolds until ECs confluence can be observed 
using fluorescent microscopy on the scaffold’s walls (when using labeled ECs), 
or for 3 days (when using non-labeled ECs), which provides enough time to 
achieve EC confluence. Change the medium every other day. 

3) In Figure2, is the scaffold only seeded with ECs? If it is, the ECs can also 
forms vessel without SCs. May you please compare the results of ECs + 
fibrin (without SCs) with the ECs + fibrin (with SCs)? 

We thank the reviewer for bringing this into our attention. Figure 2 shows, at day 
0, the confluent endothelial cells on the scaffold BEFORE SCs seeding, also 
happening at day 0. For the rest of the days, the images show the ECs+SCs co-
culture. We have not shown results of ECs + fibrin, since it has been shown in 
the literature that this system does not work for vessel formation. Nonetheless, to 
clarify this, we improved figure 2 to make explicit the presence of the SCs. Also, 
we modified the Figure 2’s legend:  

Figure 2: Representative development images and analysis of organized 
vascular networks. (A) ECs (red) reach confluence on the scaffold wall on 
which SCs are seeded; the SCs addition represents day 0 of the experiment. At 
day 1 after the SCs seeding, the ECs detach to the compartment space and start 
forming vessels that will continue sprouting and connecting at further days. 

4) It is suggested to add more characterizations of Tessellated scaffold, for 
example, SEM images. 

We have added Figure 1 to the manuscript which shows SEM images for the 
three different compartments discussed in this manuscript, with the caption: 

Figure 1: Representative scanning electron microscopy images of the tessellated 
square, circular, and hexagonal scaffold geometries (scale bar = 50 µm).   
 
Reviewer #3: 
Manuscript Summary: 
The manuscript describes a procedure for generating neovasculatures in a 
controlled, defined setting using prefabbed (via photolithography), defined 
frames (or scaffolds as called by the authors) as 1) a depot for cells and 2) 



to form a simple tissue compartment for neovessel tubes to form. This is a 
format/approach that could prove useful in studying cell dynamics 
associated with forming cell structures, such as EC cords as presented in 
this paper. 
 
Major Concerns: 
In general, the protocols are clearly written and provide good detail. While 
there is a fair amount of method details related to making the scaffolds, the 
authors should revisit that section of the writeup from the perspective that 
a user with little to no experience in photolithography would be doing the 
work. 

We appreciate the reviewer’s concerns and revised the manuscript to be as 
detailed as possible with as many generalized pieces of advice possible 
regarding the photolithography procedures. It is worth noting, that unlike the cell-
seeding protocol, photolithography is a wide-spread technique with many 
resources available to an interested reader. In the author’s perspective, this 
protocol should be sufficient for an inexperienced researcher to get started. If this 
comment was not sufficiently resolved, please provide the author’s more specific 
feedback.  
 
Line 489. The authors refer to "vessel maturation". While the addition of 
perivascular cells to the endothelial cell cord is part of the maturation 
process, the biology of vessel maturation is more involved. Besides, it's 
not clear that there is significant SMA+ cell association with the EC cords. 
The authors should qualify their conclusions concerning vessel maturation 
to better reflect their findings. 

We appreciate the author’s concern for this matter. Indeed, vessel maturation is 
a complex process that involves many factors that have not been explained in 
this manuscript. We focused on the SMA+SCs due to the possibility of assessing 
their presence using the proposed platform. The platform offers the possibility to 
observe the SCs differentiation into SMA+ cells within a 3D system with clear 
imaging that is not achievable in other system. A further verification of vessel 
maturation (such as an angiogenic cytokine array) is beyond the scope of this 
paper. Furthermore, we provided references to papers that discuss vessel 
maturation, and recruitment of perivascular cells is certainly a maturation 
milestone (Potente and Mäkinen, 2017; Welti et al. 2013).  

We agree that the SMA+ SCs and ECs cords association in the provided images 
is not completely clear, so we expanded Figure 5 (previously Figure 4) to include 
a higher magnification image that evidences the close relation between 
SMA+SCs and vascular structures. The caption was also expanded, as follows: 

Figure 5: SMA+ SCs and blood vessels increase over time. A) Smooth muscle 

actin (red) and vWF (vessels, green) are shown for vascular networks in circular, 



squared and hexagonal compartments at day 3 and day 7. Both vasculature 

extension and SMA-expressing support cells (SMA+ SCs) increase over time, 

signifying a higher vessel maturation and complexity (scale bar = 200 µm). B) 

Representative images of the SMA+ SCs denser accumulation around vessels. 

The nuclei (blue) in the composite image reveal the presence of SCs not 

expressing the SMA protein (scale bar = 50 µm). 

Line 507 Figure 2. Typically, vessel lengths are reported as the sum of 
vessel lengths divided by the area measured. While it's appreciated that the 
area examined is likely the same across all samples (given the scaffold 
pattern), reporting of the length density as opposed to just the sum of 
vessel lengths accounts for more or less area being measured between 
samples which could lead to more or less vascularity simply being 
including more or less vessels. Also, in the area plot, the Y axis label is 
"vessel area", yet the legend states "total vessel area for vascularization". 
These are two different measurements that require clarification in their 
presentation. 

We thank the reviewer for this comment, which gave us perspective on an 
overlooked topic. As the reviewer notes, the vessel length values are reported as 
the total of all the elements’ length (in mm) within the region of interest, which 
remains the same due to the scaffold geometry. These results are presented as 
Total vessel length since no normalization was done using the region of interest 
area (this would be the vessel length density, with units of mm/mm^2). Indeed, 
for comparing between different geometries, an area-based normalization should 
be done, but it is not the case for the results presented in this work. Regarding 
the vessel area, we agree with the reviewer and removed the “for 
vascularization” from the caption. Furthermore, in Figure 2, we included a yellow 
contour around the vessels which explicitly shows the way the vessel area is 
considered. The appropriate changes to the caption were made as follows: 

Figure 3: Representative development images and analysis of organized 

vascular networks. […] (B) Confocal image processing steps for vascular 

network analysis (i) A wide confocal image containing several compartments is 

taken, (ii) a single compartment is cropped (demarked by the white dashed 

hexagon), (iii) then the vascular network channel is separated, and all vessels 

outside the compartment walls are cropped out. The single compartment image 

is analyzed using Angiotool, returning a list of vascular parameters 

complemented with visual markers, such as the vessel area (outlined in yellow), 

the vessels length (displayed with green lines), and the intersection points 

(marked as blue dots). (C) Comparative results of the total vessel length and the 

total vessel area within hexagonal compartments at different time points (results 

are presented as mean ± SD, n > 6; all scale bars: 200 µm). 



Line 543. Throughout the paper, the authors describe the neovessel tubes 
as "highly organized vascular networks". Can the authors define better 
what is meant by "highly organized"? Are they referring to the network 
architecture, the distribution of neovessel tubes within the space, the 
formation of neovessel tubes, etc.? 

We included the following text in the Representative results section, to clarify the 
meaning of highly organized vascular networks: 

When using a traditional simultaneous seeding of both ECs and SCs, the 
resulting vessels lacked a clear organization. […] In this fashion, the cells are 

homogeneously distributed over the scaffold (Figure 2, top row), resulting in 
unpredictable and disorganized developed vascular networks that do not seem to 
interact with the surrounding scaffold. Contrarily, firstly seeding the ECs on the 
scaffold walls provides an accurate initial endothelial cell patterning. The later 
addition of SCs within a fibrin gel results in a predictable tubulogenesis 
phenomenon, with forming vessels closely following the shape of the scaffold 
wall, and sprouting new vessels migrating into the compartment space (Figure 2, 
bottom row). 
 
Minor Concerns: 
Line 112, 1.1.1 Plasma clean wafer. Details or a reference should be 
provided. 

The authors have provided additional detail in the revised manuscript. 

Line 117-119, 1.1.2 how is the spinning performed? When inspecting, what 
are you looking for to indicate complete coating? 

This has been clarified in the updated manuscript.  

Line 124, how do you determine when 100 um thickness has been 
obtained? 

1.1.4 is the header of that step. It was noted under 1.1.4.3 that “The actual 
thickness of the resist and the resultant scaffolds will be dependent on many 
factors. Therefore, the thickness of the scaffolds should be verified later, in 1.7. 
Modify spin coating procedures accordingly to achieve the desired thickness.“  

1.7 reads: “Following the hard bake, and prior to lift-off is the most advantageous 
time to assess scaffold thickness since the scaffolds should still be gently 
adhered to the surface of the wafer. For this procedure, contact profilometry 
works well; however, any appropriate method could be employed.”  
 

Line 155, is it clear to readers how to make a photomask? 



There are many differences in photolithography apparatuses, which make it 
difficult to provide a “one size fits all” method for preparation of photomasks. If a 
reader is interested in following this procedure, there are ample resources 
available, including companies, to support the design and production of the 
necessary photomask. The use of terms like “hard glass or quartz” and “soft 
polymer transparent film photomask” in the context of “photolithography” should 
be the key words readers need to start their process. More importantly, the 
authors noted under 1.2 that glass photomasks are higher resolution than 
transparencies, as the choice a cheaper film photomask vs a more expensive 
glass photomask will likely cause topographical features on the scaffolds as a 
function of poorer feature resolution.   

Line 245, 3.7. Is visualization done by phase or is the fluorescence-based 
method described earlier needed? 
 
A clarification was added as follows:  

3.2. Make a human adipose microvascular endothelial cell (HAMEC) suspension 
in EC medium with a concentration of 4·106 cells/ml.  
 
NOTE: Real time imaging can be performed if the used endothelial cells are 
previously transfected to express a fluorescent protein, or pre-stained using a 
non-toxic cytoplasmic membrane dye (furtherly referred as labeled ECs). 
 
[…] 

 
3.7. Incubate the endothelialized scaffolds for up to 3 days (when using non-
labeled ECs), or until cell confluence can be observed with a confocal or 
fluorescent microscope on the scaffold’s walls (when using labeled ECs). 
Change the medium every other day. 

 
Line 251, 4.1. Is there a need to lot test the fbs, as some cell types are fbs 
lot-sensitive. 

We do not think that an FBS lot test is necessary. For culturing HAMECs, we 
have always used the mentioned ECM from ScienCell, which provides its own 
FBS. As for the DPSC, we have used two different FBS brands and several lots 
from each and we have not observed significant differences in their growth and 
functionality.  

Line 261, 4.2.2. The phrase "…running liquid towards the wall…". Is this 
referring to surface tension effects? 



Indeed, the phrase refers to the surface tension effects, and thanks to this 
comment, we modified the text to clarify this matter: 

4.2.2. Place one scaffold per well, preferably at the center of the well to avoid 
running liquid toward the walls due to surface tension effects. Dry the area 
surrounding the scaffold with light vacuum but avoid complete drying of the 
scaffold. 

Line 285, 4.3.6. Perhaps instead of "gently" use the term "slowly". 

We have modified the text as follows:  

4.3.5. Slowly press the plunger button until the liquid reaches the tip opening but 
does not leak out. Hold the plunger in this position and put the tip into one of the 
eppendorfs containing the cells in thrombin suspension, making sure the tip is in 
contact with the liquid. 

 
Line 299, 4.6.2. With the confocal imaging, is there a need to fluorescently 
label the cells or is the expectation that the cells are pre-tagged as 
described earlier? Either way, the authors should indicate in this entry the 
expectation. 

At step 4.6.2. we added the following note: 

NOTE: This step can only be performed if the experiment is performed using 
labeled ECs. See Step 6 for further clarification. 
 
This will refer the reader to the following note which was included in the original 
manuscript: 
 
NOTE: The following steps can be performed on the fixed and stained scaffolds 
at the chosen final time point or, if fluorescent cells were used, during the cell 
culture period without the need to terminate the experiment. For the latter, it is 
recommended to set specific time points; this work shows day 0 (before SCs 
seeding), and days 1, 3, 5 and 7 after SCs seeding (Figure 2A). 

Line 312, 5.2. Is the paraformaldehyde prepared in PBS? 

In the materials list, it can be found that the proposed PFA is obtained as a 4% 
solution with no need for dilution. 

 
Line 318, 5.4. Can other blocking agents besides BSA be used? 



There is a wide variety for staining protocols that use an extensive range of 
different reagents (different primary and secondary antibodies, different Tryton-X 
concentrations, and so on). We have only referred to what was used for the 
current experiment, and verifying other reagents is outside the scope of this 
work. Nonetheless, we are confident that other known staining protocols using 
other blocking agents (e.g. FBS) will work without noticeable changes. 

Line 351, 6.2. The inclusion of a schematic or diagram (or labeling of 
provided images) would be useful in indicating the different compartments 
the authors are referring to in this description. 

Thank you for this comment. We greatly expanded step 6.2 to make the process 
clearer, which also allows to understand the compartments better. We also 
added in figure 2C a frame representing the area to be cropped, following the 
shape of the compartment. The following text was added to the figure caption to 
further clarify the matter: 

Figure 2: Representative development images and analysis of organized 
vascular networks. […] (B) Confocal image processing steps for vascular network 
analysis (i) A wide confocal image containing several compartments is taken, (ii) 
a single compartment is cropped (demarked by the white dashed hexagon). 

Moreover, we included a new figure (Figure 1) with SEM images of the resulting 
scaffolds in which the compartments can be easily seen. 

Line 402, 7.1.3. The authors describe imaging intervals based on practical 
considerations. Based on their experience with the model, the authors 
should also present temporal information related to the time course of 
relevant biological events (e.g. cell migration occurs over hours vs days, 
etc.) to help others set imaging intervals, as needed. 

Thank you for this comment. We included the following note after step 7.1.3 to 
explain the critical time points, so readers can choose the time step and starting 
time point according to their needs: 

NOTE: ECs detachment from the scaffold walls and tubular structures formation 
will start within the first hour after SCs seeding (step 4) and may take up to 50 
hours to complete. After initial tube formation, new sprouts will start migrating into 
the compartment from the surrounding vessels. Sprouting and subsequent 
network remodeling will continue throughout the experiment until day 10, in which 
the vessel networks become stable22. Use this information to choose the time 
lapse starting point and time step accordingly. 

Line 501 Figure 1. The authors should refer to the specific protocol steps in 
which simultaneous vs step-wise seeding was performed. 



We thank the reviewer for this comment. To address this, we added the following 
text in the Representative results section: 

Using a stepwise cell seeding (steps 2 to 4), the fabricated scaffolds can be used 
to create highly organized vascular networks. […] To compare the step-wise 
seeding vessel organization capabilities, a traditional simultaneous seeding of 
both ECs and SCs was done. For this, the scaffold fibronectin coating was 
performed (step 2), the scaffold endothelialization step was skipped (step 3), and 
the DPSC and HAMEC were simultaneously co-seeded in fibrin gel (step 4). 

Line 519 Figure 3. Are the different colors used to identify individual ECs. If 
so, this should be stated in the legend. 

We appreciate the reviewer comment. We agree that there is a need to clarify the 
purpose of the multicolored ECs, and the following changes were made on the 
manuscript body to address this matter: 

Using multicolored ECs to facilitate single cell identification, a confocal imaging 
time lapse was performed to allow single vessel tracking (Supplementary Video 
1). 
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